
  

Lumion 12.5: Release Notes  

31 May 2022  

Compatibility 

• Please note that Projects and models saved in version 12.5 cannot be opened in older versions of 

Lumion.  That also includes versions 12.0, 12.0.1, 12.0.2, 12.3, and 12.3.1. 

• Please click on the following link to see how to transfer settings, models, and Projects from older 

versions of Lumion: 

o Knowledge Base: Lumion 12.5: Everything you need to know 

1. Changes & Resolved Errors 

1.1: Build Mode: 

1.1.1 Objects and Object Library:  

• Switching between Variations of the same Imported Model now updates the shadows. 

• Object Insertion Points are now rendered in the correct position when many distant objects are selected. 

1.1.2 Place Mode: 

• Objects added using the Paint Placement Tool are now placed on the active Layer rather than being 

placed on Layer 1. 

1.1.3 Groups: 

• Grouped objects from the Effects Category now maintain their relative position to the Group's Origin 

Point when the Group is moved. 

• Edit Group: selecting one Object in a Group now only highlights that Object and not all Objects within 

the Group.  

1.1.4 Layers: 

• The Layer tab is more responsive when renaming Layers. 

• The Layer name display has been improved. 

• The name of Hidden Layers is now displayed when hovering over the Show/Hide icon. 

• Layer names being displayed as numbers: this is now based on the available on-screen space instead of 

the number of Layers. 

• Hidden Layers no longer become visible when loading a Project for the first time in a Lumion session. 

1.2: Photo, Movie, and Panorama Modes:  

Photo Mode, Movie Mode & Panorama Mode: 

https://support.lumion.com/hc/en-us/articles/4949588512668


• The High-Quality Preview is no longer dark when the Editor Resolution is set from 50% (Performance) 

to 77% (Ultra). 

• The Photo/Movie/Panorama Preview is now always rendered at the same resolution as selected in the 

Settings. 

Movie Mode: 

• Record Clip: the FX on/off toggle button is now fully displayed in all languages available in Lumion.  Its 

label is now FX and the Help Tooltip will show if the button is On or Off. 

Panorama Mode: 

• The Waypoint icon in Lumion now corresponds with the correct Panorama when clicked. 

• Waypoints are now functional at all Editor Resolutions. 

1.3: Effects & Styles 

• Landscape Grass applied on an Imported Model is now rendered when the Reflection Effect is Off and 

the Precipitation Effect is On. 

• Advanced Move Effect: animations no longer loop at the Clip length when the Auto/Use clip length 

toggle button is set to On. 

• Layer Visibility Effect: Layer states for Layers 21 to 32 can now be modified after opening a file from 

Lumion 12.0.2. 

• Transparent Materials hit by sunlight no longer result in unusually high brightness when rendered in 

Print Resolution with the Hyperlight Effect active. 

1.4: Materials 

• Material maps (Normal and Gloss ) that are auto-generated by Lumion are now resized correctly when 

the texture resolution is larger than 16384 x 16384 pixels and the aspect ratio is non-square. 

• Standard Material:  MP4 Video Texture files are now stored only once in the Documents\Lumion 

[version]\Miscellaneous\Video Textures folder. 

• While editing Materials, Lumion will now display correctly the yellow outline surrounding surfaces 

where a Material has already been assigned. 

1.5: Save, load, and recovery functions 

• The Save button is no longer greyed out after overwriting a Project file using Save As...  

1.6: Importing and Exporting 

• Add Variation: Variations to Imported Models added while in Material Mode no longer get discarded or 

replaced Materials. 

• A red screen is no longer displayed when starting Lumion via Livesync with Camera synchronization set 

to Off. 

• When Lumion becomes the active window, the Field of View is reverted to its original value instead of 

retaining the 3D modeling software camera data. 

• Planar Reflections are now displayed as expected when added to Imported Models that originate from 

SketchUp. 

• Hidden surfaces from SketchUp should no longer be visible when importing the '.SKP' file to Lumion. 



• Various fixes for geometry normals. 

1.7: Miscellaneous 

• Switching from Settings to Photo or Panorama Modes after a fresh start of Lumion no longer creates 

display issues for the camera. 

User Interface:  

• Mouse interactions with the user interface are more responsive and no longer sluggish in heavy Projects 

or Projects with low framerates. 

• Japanese 2-byte characters no longer disappear when naming images. 

• Various UI improvements. 

 

Lumion 12.3: Release Notes  

1 March 2022  

Compatibility  

• Please note that Projects and models saved in version 12.3 cannot be opened in older versions of 

Lumion.   

• Please click on the following link to see how to transfer settings, models, and Projects from older 

versions of Lumion:  

 o  Knowledge Base: Lumion 12.3: Everything you need to know  

Features, models, and materials with the asterisk (*) character are only available in Lumion 12.3 Pro.  

See the full product comparisons here for Lumion 12 (Compare versions table - Comparison tab): • 

 Lumion website: Lumion 12.3 Features  

 

1. New Feature Highlights  

1.1: Volumetric Lights Effect*  

Available in Photo, Movie, and Panorama modes.   

Omnilights are now included in the Volumetric Lights Effect. This allows for mixing and matching both types of 

Lights within this Effect.  

https://support.lumion.com/hc/en-us/articles/4419818010898
https://support.lumion.com/hc/en-us/articles/4419818010898
https://lumion.com/specifications.html#chart
https://lumion.com/specifications.html#chart


  
Lumion 12.3 lets you add a gorgeous glow of light to interiors and exteriors with the improved Volumetric 

Lights Effect. This subtle lighting detail only takes a click, infusing spaces with warm, inviting lights. When 

used with fog, an atmospheric real sky, or precipitation, you can instantly create a stunning result.   

• Rendering a foggy, moody night  

• Visualizing event lighting  

• Create a cinematic effect to delight clients  

• Show dust, mist, or steam for interior and exterior shots  

• Magnify a sense of volume in spaces  

   

1.2: Custom Surface Decals*  

In Lumion 12.3, you can now import your own surface Decals to add a touch of your personality and character 

to the materials.  

Simply import a custom image and place it on any surface, and the image will take on all the traits and texture 

of the material beneath it.  



  
Combine the Custom Decal import feature with other Lumion features, such as Displacement Maps and 

Weathering, to make your materials even more unique and personalized.  

  

   



1.3: Custom License plates  

With this version, you can also load your own License Plates for vehicles.  

 •  Transport Category: Option to add Custom License Plates in this category.   

  

1.3.1 License Plate Sets can be created, saved, and loaded in your Project containing up to 10 different entries 

with Front and Rear customization available:  

  
A dedicated panel is also available that allows for scaling the plates to the desired size:  

  

1.3.2 An infobox has been added as a disclaimer regarding the content of the preset License Plates.  

  

   

  



1.4: Render multiple Photo Sets   

It is now possible to render multiple Photo Sets or a selection of Photos that belong to different Photo Sets. This 

feature is a workflow boost when a large number of images need to be rendered.  

  

The total number of selected Photos for rendering is displayed under the Photo set label and excluded Photos 

within a Set will appear greyed out. By default, all Photos are selected.  

  

   

2. Other Features and Improvements  

2.1: Build Mode  

2.1.1 Layers  

Lumion 12.3 now features 32 editable Layers.  



  

2.1.2 Improved Object Library - animated Nature Library  

Transform landscapes into living experiences with 110 newly animated Weeds and other Nature objects. These 

previously static items now move with life, creating the context for more detail-rich, vivid animations.   

  

2.2: Importing  

 •  A new importer is now being used for .SKP and .DWG files.  

2.3: Materials  

Standard Material  

•  Waxiness and Transparency: the Waxiness and Transparency sliders can now be tweaked at the same 

time, instead of just one at a time.  



  

2.4: Example Projects and Templates  

Two new Example Projects have been introduced to showcase Lumion features.  

  

Learn about:  

• Kaufmann House:  o  Creating a realistic landscape, atmospheric Effect Stacks, and applying 

Decals.  

• Streetscape:  

 o  Setting up an urban scene with animated objects and Volumetric Lights.  



2.5: Miscellaneous  

Drag and Drop  

• It is now possible to drag and drop .LS12 files into Lumion to Load or Merge them in your Project. This 

can be done both in Build Mode (Content Library Mode) and on the Welcome Screen after a Project has 

been loaded.  

  

• Models can now also be imported by dragging and dropping them in Build Mode.  



  
   

3. Other Changes & Resolved Errors  

Build Mode  

3.1: Objects and Object Library:   

3.1.1 Search function: •  Using two search terms ('new ...') now returns the correct objects instead of 

skipping the second search term. Example: new chair:  

  

3.1.2 License Plates:  

• The Front and Rear of the UK License Plates now have different colors:  



  

3.1.3 Object Library:  

• Effects -> Decals: Selecting multiple Decals with different orientations no longer resets their Rotation.  

• Effects -> Fountain Objects: the Brightness slider now works as expected without having to change the 

color.  

• Utilities -> Landscape Cutter: The Control Points are now displayed only when a single Landscape 

Cutter Object is selected.  

• Various Objects: Fixed the materials so that the correct shading occurs for some Objects in the Library 

that had a broken material.  

• Various Objects: Fixed the materials so that certain Objects no longer have a metallic finish.  

• Various Transport Objects: The Show driver toggle is no longer displayed for Objects that do not have a 

driver.  

• Various Transport Objects: The Metallic slider has been removed for Objects that are not affected by it.  

3.1.4 Lights:  

• Spotlights: the Custom IES Profile names are now displayed correctly and fit the User Interface.  

• Area/Line Lights: modifying the values for Width, Length, and Falloff when multiple Area/Line Lights 

are selected will now update for the whole selection.  

3.1.5 Layers:  

• Move selected Object to Hidden Layer: Lumion no longer becomes unresponsive when a selected Object 

is moved to a Hidden Layer unless the right mouse button (RMB) is clicked.  

• Hidden Layer visibility: selecting a Hidden Layer in  Build with FX no longer makes it visible when 

returning to Build Mode.  

• Build with FX: The Layer states from the Layer Visibility Effect applied to Photos, Clips, and 

Panoramas are now respected when entering Build with FX.  

3.1.6 Groups:  

• Group collision: A Group should no longer intersect with an invisible copy of itself when placing it in 

the Project.  

• Move Objects in Group: The Move Gizmo has been removed when selecting objects within a Group 

since those objects could not be moved.  



• Group creation: When creating a Group, the UNDO action is now reset.  

• Group editing: UNDO actions have been added for Move, Rotate and Scale during Group editing.  

3.1.7 Landscape:  

• Height: the position of Imported Models on Hidden Layers is now updated when changing the 

Landscape Height to keep the same relative distance between the two.  

• Height: the camera is no longer affected by incorrect collision data after switching from Landscape 

Height to Movie Mode.  

3.1.8 Other usability improvements:  

• Space Objects Evenly: this feature now measures accurately the distance between Objects from their 

Insertion Point.  

• Replace Selection: The Insertion Point no longer displays a small offset from the real center of the 

Object.  

• Place Item on Nodes: If no Object is selected in the Library to place, the OK button will not be displayed.  

• Performance Monitor: Fine-detail Nature and Sound Objects are now counted by the Performance 

Monitor and displayed under their main Category (Nature, respectively Effects).  

• Performance Monitor -> FPS counter: the FPS no longer drops considerably when selecting multiple 

Objects within the Transport Category.  

   

3.2: Materials:  

• Materials -> Standard Material: when holding Shift to adjust the Transparency the slider now changes 

the values rounded at the closest 0.01.  

• Materials -> Standard Material: .PNG transparency is now displayed correctly.  

• Materials -> Standard Material: The Flip Normal Map Direction button is displayed after adding the 

Material to the Custom Materials list.  

• Materials -> 3D Grass: The mesh tesselation of the surfaces where the 3D Grass is applied has been 

improved for efficiency and to prevent missing mesh triangles.  

   

3.3: Importing and Exporting   

• Camera LiveSync: Certain models could be rather slow when syncing the camera. This process has now 

been improved and the camera sync should be much snappier.  

• .FBX format: Geometry normals are displayed as expected and no longer flipped for Objects that were 

imported after being mirrored in the original 3D modelling software.  

• .OBJ format: Imported Models originating from SEMA are now imported at the correct scale (meters).  

   



3.4: Photo Mode, Movie Mode, Panorama Mode   

• Emissive Materials with Transparency are rendered correctly in Print/Poster Resolution. In previous 

versions, the Emissive value would be ignored.  

• Light Objects which were previously selected while editing Effects (Global Illumination, Animate Light 

Colors, and Volumetric Lights) no longer remain selected in the Preview after the editing is finished.    

• Thumbnails are no longer black when Projects contain 3D Text Objects.   

• Titles are no longer display briefly the name of the previously selected position.   

• Output extensions: known file extensions on a PC no longer overwrite the extension of the rendered 

Photo/Clip/Panorama. 3.4.1 Photo Mode  

• Context Menu: Photos in Photo Set 2 and higher can now be deleted from the Context Menu.   

• Entering Photo Mode: when Thumbnail creation fails, Lumion will skip generating the Thumbnails.  

3.4.2 Movie Mode  

• The 'Click inside the preview to update' message flickering has been addressed and doesn't occur when 

scrolling through the Clip Set.  

• 'Image from file' and 'Movie from file' have been renamed to 'Clip from image file', respectively 'Clip 

from Movie file'.  

   

3.5: Effects & Styles   

• Orthographic View Effect:  o  Volumetric Lights are now correctly rendered in orthographic projections.  

o In 3D View, Horizontal Eye Level now behaves as intended.  

• Volumetric Lights Effect:  o  The selected lights are now correctly rendered in Planar Reflections.  

o The selected lights are colorized by the glass when they are placed behind a PureGlass Material.  

• Material Highlight Effect: 2D Characters and Character Billboard Objects no longer mask this Effect.   

• Phasing Effect: The MOUSE WHEEL can now be used to navigate through pages.  

• Global Illumination Effect and Reflection Effect: Landscape Grass is now visible when using those two 

Effects at the same time.   

• Layer Visibility Effect: Visible Layers in Build Mode no longer get overwritten by the settings of this 

Effect.  

• Mass Move Effect -> Place New Path button no longer gets stuck when trying to use the Effect in a 

second Clip.  

• Precipitation Effect:  o  While enabling SpeedRay Reflections, puddles on sloped surfaces no 

longer create artefacts.  

o A black shadow square no longer appears when using this Effect together with the Variation 

Control Effect.  

   

3.6: Save, load, and recovery functions  

• 3D Grass in older .LS files: Projects containing 3D Grass which displayed an error ('Out of memory') 

when loaded in Lumion 12.0.2 and did not load, now open as expected.  

• Merge: Objects in the Utilities Category are no longer counted during this process as they are not 

merged.  



• Recovery files: are now automatically discarded when starting Lumion by double-clicking an .LS file.  

• Import Screen: Long model names are now displayed correctly.  

   

3.7: User Interface   

• Various minor interface changes:     
 o    

 Volumetric Spotlights Effect: has been renamed Volumetric Lights as it can now also be 

applied to OmniLights.  

 Mouse Wheel Up/Down navigation: is now available in Movie Mode when scrolling 

through Clips.  

 Toast notifications: are also displayed after rendering a Photo Set or an Image Sequence. 

  Other minor text and layout of the text changes.  

• Translations: Various missing translations have been added.  

• Watermark:  o  in Build Mode it no longer scales with the Editor Resolution. o  has been updated for 

the Lumion Trial, Lumion Business Trial (Pro Trial), and Lumion Student/Faculty.  

   

3.8: Miscellaneous   

• Lumion Viewer: The High-Quality Preview no longer gets rendered during playback of a Movie/Clip.  

• Example Projects: Various tweaks to the examples and templates.  

   

From the Team:  

Enjoy learning and using Lumion 12.3.  



  

   

  

  


